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1. 概要 

本資料では、pure::variants Enterprise  システムのデスクトップクライアントとライセンスサー

バーの新規インストールの手順を説明します。 

pure::variants  システムは、クライアント、ライセンスサーバー、モデルサーバー、他のコンポ

ーネントで構成されますが、セットアップの詳細や更新など他の手順、モデルサーバーや Web ク

ライアントなど他のコンポーネントのインストールについては、本資料の基である Setup Guide

の英語版( pure::variants Setup Guide: Version 6.0.0.685 for pure::variants 6.0 － pv-setup-

guide.pdf  )を確認ください。これは、インストールされた製品のオンラインヘルプや PDF で入手

できます。以下のページに html 形式でも公開されていますので、ブラウザーの翻訳機能を活用い

ただくこともできます。 

https://www.pure-systems.com/pv-update/additions/doc/latest/com.ps.consul.eclipse.pv.setup.doc/index.html  

https://www.pure-systems.com/pv-update/additions/doc/latest/pv-setup-guide.pdf
https://www.pure-systems.com/pv-update/additions/doc/latest/com.ps.consul.eclipse.pv.setup.doc/index.html
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以下には、Setup Guide や User Manual、各種コネクタの Manual も公開されています。 

https://www.pure-systems.com/support/purevariants-technical-documentation 

pure::variants  ライセンスサーバーは、TCP  接続によって pure::variants  クライアントの複数の

ユーザーにフローティングライセンスを与えます。  pure::variants  ライセンスサーバーにはWeb  

インターフェースがあり、ライセンスの使用状況の確認や、日割り単位でのオフサイトライセンス

の貸し出しなどを行うことができます。 

2. システム構成と要件 

システム構成 

pure::variants  の全体像は下図のとおりで、使用するエンジニアリングツールと  pure::variants  

モデルに必要なデータ管理モードに応じて  pure::variants  のセットアップは図のオレンジ色のボ

ックスで示されるコンポーネントの一部またはすべてで構成されます。ブラウザーや LDAP サー

バーなどのような青色のボックスは、必要なコンポーネントで pure-systems 社が開発や提供を行

わないものです。 

コンポーネントは、サーバーインフラ上で実行されるコンポーネントとユーザーのデスクトッ

プクライアントのマシン上で実行されるコンポーネントにグループ分けされます。 

pure::variants Enterprise のデプロイには、管理のために pure::variants デスクトップクライ

アントを少なくとも 1 つと、pure::variants ライセンスサーバーをインストールすることが必要

です（ Setup Guide の  3. pure::variants Desktop Client、4. pure::variants License Server  を参

照）。 

pure::variants Enterprise は、 ロー カル なフ ァイ ルベ ース での 操 作と pure::variants 

Enterprise モデルサーバー上の pure::variants プロジェクトの集中管理記憶域での操作とをサ

ポートします。pure::variants デスクトップクライアントでは両方の操作モードがサポートさ

れ、pure::variants Enterprise Web クライアントでは pure::variants モデルサーバー上の集中

管理記憶域だけがサポートされます。  

使用する組織での必要性に応じて pure::variants モデルサーバーや、pure::variants Web ク

ライアント、pure::variants Web コンポーネントで提供されるサービスをデプロイする場合、

pure::variants Docker デプロイメントテンプレートを利用するアプローチが推奨されます

（Setup Guide の 5. pure::variants Deployment Templates for Docker を参照）。それによって必

要なコンポーネントやサービスのデプロイと更新が効率的にできます。  

  

https://www.pure-systems.com/support/purevariants-technical-documentation
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システム要件 

pure::variants  には、インストールするソフトウェアに応じて異なるシステム要件があります。

それらすべてのシステム要件を下表に示します。 
  

pure::variants 

ソフトウェア 
OS 前提ソフトウェア メモリ 

pure::variants 

デスクトップクライ

アント 

x-64上の64ビットOSのみサポート 

 Windows 10, 11 

 Windows Server 2016, 2019 

 Linux (X11ウインドウシステム要) 

 macOS 

 Oracle Java SE もしくは OpenJDK 

サポートする Javaバージョン:  

• Java 8 - 17 

 Eclipse 4.6 - 4.25 

最小：4GB 

推奨：8GB 

ライセンスサーバー 

x-64上の64ビットOSのみサポート 

 Windows 10, 11 

 Windows Server 2016, 2019 

 Linux 

 最小：512MB 

推奨：1GB 

データベースをもつ 

モデルサーバー 

x-64上の64ビットOSのみサポート 

 Windows 10, 11 

 Windows Server 2016, 2019 

 Linux 

 Oracle 12 - 21c 

 MSSQL Server 2016 - 2019 

 PostgreSQL 13.x - 15.x with 

PostgreSQL ODBC Driver version 13.x 

最小：4GB 

推奨：8GB＋ア

クティブユーザー*

ごとに1GB 

Webコンポーネント 

x-64上の64ビットOSのみサポート 

 Windows 10, 11 

 Windows Server 2016, 2019 

 Linux 

 Oracle Java SE もしくは OpenJDK 

サポートする Javaバージョン:  

• Java 11 - 17 

 Apache Tomcat 8.5.x/9.x も し く は

WebSphere Liberty Kernel v19.0.0.6 

 サポートするブラウザー（旧バージョンは最大6

か月サポート） 

• Chrome、Firefox、Edge 

最小：2GB 

推奨：32GB 

アクティブユーザー

がオープンする固

有のリビジョンで

1000要素**のモ

デルのブラウザー

セ ッ シ ョ ン ご と に

100MB 

Javaの互換性は、オラクル社提供の公式 Java Standard Edition (https://www.java.com/en/download/) と

オラクル社提供の OpenJDK (https://jdk.java.net/archive/) でテストされています。 

pure::variants 

ソフトウェア 
CPUコア数  ディスク領域  DBスペース 

pure::variants 

デスクトップクライ

アント 

最小：2 

推奨：4 

最小：10GB空き領域  

ライセンスサーバー 
最小、 

かつ推奨：2 

最小：10GB空き領域 

データベースをもつ 

モデルサーバー 

最小：4 

推奨：4（10アクテ

ィブユーザーまで） 

以降、10アクティブ

ユーザーごとに1コア

追加 

最小：10GB空き領域 

（大部分はログに使用 

プ ロ ジ ェ ク ト デ ー タ は

DB スペースに保持） 

プロジェクトやモデルの規模に依存  

 MSSQL：1000要素とリビジョンごとに 20MB 

 Oracle：1000要素とリビジョンごとに4MB 

 PostgreSQL：1000要素とリビジョンごとに15MB 

Webコンポーネント 
 

*  アクティブユーザーとは pure::variants のサーバーを同時に使用するユーザーのことです 

** 1000要素には、すべてのフィーチャ、ファミリーモデルの要素、バリアントモデルでの選択が含まれま

す。また、リビジョンを作成するとスペースが２倍になります 

https://www.java.com/en/download/
https://www.java.com/en/download/
https://jdk.java.net/archive/
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3. pure::variants デスクトップクライアントのインストール 

pure::variants デスクトップクライアントはスタンドアローンアプリケーションとして

pure::variants  インストーラーを使用してインストールするか、既存のEclipseツールチェーンに

インストールします。 

pure::variants  インストーラーは Windows  用だけですので、Linux  や macOS  にインストール

する場合は既存のEclipseにインストールすることになります。詳細は 3.3節「既存のEclipseへの

インストール」を参照ください。 

最初のインストールが完了後に  pure::variants  を使用するためには、続いて説明するライセン

スのインストールが必要です。 

また、フローティングライセンスを使用される場合は、ライセンスサーバーからライセンスを得

るためにライセンスサーバーのURLも必要です。 

3.1 pure::variants インストーラーによるインストール 

Windows  用インストーラーは、pure::variants  のサイトhttps://www.pure-systems.com/pvde-

update からダウンロードできます。このダウンロードページはパスワードで保護されており、メ

ールアドレスとライセンスファイルにある登録番号でログインする必要があります。 

インストーラーパッケージ ( pure::variants Windows Installer Package  ) をダウンロード・解

凍し、「Setup Enterprise X.Y.ZZ.exe」（X.Y.ZZはバージョン番号）をダブルクリックしてイン

ストールを開始し、以降に示すウィザード（Setup Guideの pp.9-11）の手順に従います。 

＊ 一 般 に イ ン ス ト ー ル ソ フ ト は 、 お 客 様 に メ ー ル で ご 案 内 す る pure-systems 社 サ イ ト  

(https://www.puresystems.com/pvde-update)  から、ユーザー名とパスワードでアクセスして

ダウンロード頂いています。特に初めてのお客様の場合は、下図の  pure::variants Windows 

Installer Package  をお勧めします。Eclipse を含めて、全てのライセンスオプションがイン

ストールできます。  

 

 

ユーザー名  

https://www.pure-systems.com/pvde-update
https://www.pure-systems.com/pvde-update
https://www.puresystems.com/pvde-update
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このインストーラーは pure::variants  と新規の Eclipse、そしてドキュメント類をセットアップ

します。インストールには管理者権限が必要です。 

アカウントに対して利用可能な  pure::variants  の拡張すべては、ダウンロードしたインストー

ラーに自動的に含まれますが、そのうちいくつかはインストーラーのデフォルトでは有効になら

ないので、必要なものをインストールプロセス中に選択してください。（この選択を後でアップデ

ートするには、pure::variantsを再インストールするか、Eclipse  のアップデートサイトから実施

できます） 

また、pure::variants  を実行するには Java  の実行環境 (JRE) が必要です。ご利用の PCに Java 

がない場合は、先にインストールしてください 1。 Java  は https://www.java.com/ja/  からダウンロ

ードできます。64ビット版のバージョンで、対応する最新のものを使用することが推奨されていま

す。 

インストーラー（ ）を起動し、以下の手順ですすめます。 

 

 

 
1 インストーラー実行時に右のようなメッセージが出た場合、

JRE がインストールされていないか、java.exe がデフォル

トの場所 (C:¥Program Files¥Java¥jre1.8.0_301¥bin¥  

など) でないことが考えられます。 

java.exe がデフォルトの場所でないときは、コマンドプロ

ンプトから /JAVA オプションで  java.exe のインストー

ル場所を指定して、「Setup Enterprise X.Y.ZZ.exe」を

実行してください。 

Next  > をクリックします。 

https://www.java.com/ja/
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ライセンス契約を読んで同意し、

Next  > をクリックします。 

pure::variants  デスクトップクラ

イアントをインストールするフォ

ルダを選択し、Next  > をクリック

します。 

pure::variants  デスクトップクラ

イアントと一緒にインストールす

るコネクタを選択した後、Next  > 

をクリックします。 
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次のウィザードで  Install  ボタンが表示されますので、クリックしてインストール処理を開始し

ます。(コネクタのインストールがある場合、pure::variants  の統合に関するページが表示される

ことがあります。統合のコネクタが選択されていない場合 Install  ボタンが表示されます)。 

 

3.2 pure::variants デスクトップクライアントのアンインストール 

pure::variants  デスクトップクライアントのアンインストールには、Windows  のスタートメニュ

ーで アプリと機能  から pure::variants Enterprise  を選択し、「アンインストール」でアンインストーラーを

実行します。 

別に、次のようにpure::variants  デスクトップクライアントのインストールフォルダからアンイ

ンストーラー (uninstall.exe) をダブルクリックして実行する方法があります。 

Windows  のスタートメニュー項

目の名前を入力します (作成しない

こともできます)。Next > をクリ

ックします。 

Show further manual installation 

steps オプションをチェックする

と、Finish  時に、統合に関する詳

細や手動でのインストールに関す

るドキュメントが開きます。 
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アンインストールには管理者権限が必要です。  

 
 

 

 

 

Next  > をクリックします。 

Uninstall をクリックしてアンイ

ンストールを開始します。 
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3.3 既存の Eclipse へのインストール 

ここでは、Eclipse  のパッケージマネージャによって、アップデートサイトから直接コンポー

ネントをダウンロード（もしくはダウンロードしたアップデートファイルを指定）して更新す

る方法の概要を説明します2。ターゲットとなる  Eclipse  に次の項目がインストールされている

か、Eclipse  のリリースアップデートサイトにアクセスできることが必要です。  

• JavaScript Development Tools：org.eclipse.wst.jsdt.feature.feature.group  

• Eclipse Business Intelligence and Reporting Tools (BIRT)：org.eclipse.birt.feature.group 

• Graphical Modeling Framework：org.eclipse.gmf.feature.group 

Eclipse  を起動し、Help > Install New Software...  を選択して Available Software  ウィザードでア

ップデートサイト  pure::variants update site  を選択します。pure::variants update site  が Work with  

 
2 Windows では、前述のインストーラーパッケージを使用して既存の Eclipse にインストールすることもでき、そ

の方法が推奨されています。 

 

アンインストール完了後、Finish

で終了します。 
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フィールドのリストにない場合、Add  して直接入力します。 

 

 

 

 

 

 

 

 

 

 

 

 

 

アップデートサイトは  https://www.pure-systems.com/pvde-update/ です。 

 

  

Location 欄にアップデートサイトの URL を

指定する以外に、 

Local... をクリックしてアップデートファイ

ルを指定するか、Archive... をクリックしてア

ーカイブを指定するかできます。 

ダウンロードしたインストーラーパッケージ内にあります。 

ダウンロードサイトの「pure::variants Archive Update Site 

with all Extensions」です。 

https://www.pure-systems.com/pvde-update/
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Location欄にアップデートサイトのURLを指定した場合、下図のようにpure-systems 社サイ

トへのログインが必要です（p.  5 参照）。  

 

 

 

 

Name欄で項目を選択して Next >  をクリックし、インストール手順を進めます。詳細は、pure-

systems 社ダウンロードサイトにあるビデオ  (p.5 のダウンロードサイト図中の２番目の  movie) 

や Setup Guide  の 3.1.2. Install into an existing Eclipse  を参照ください。 

  

メールアドレスとライセンスファイルにある登録番号で

ログインします 
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3.4 pure::variants デスクトップクライアントライセンスのセットアップ 

pure::variants  を使用するには有効なライセンスファイルが必要です。ライセンスなしで

pure::variants  を起動し、ライセンスを要求された場合は、 Yes をクリックしてウィザードで提供

されたライセンスファイルを指定します。メールでお送りしたクライアントライセンスファイル  

(xxx_license.lic) をインストール フォル ダ  ( 上記手順のデフ ォルトでは  C:¥Program 

Files¥pure-systems¥pv_Enterprise_6.0) にコピーしてください。 

次に  pure::variants  を起動してライセンスファイルの場所を設定します。メニューから  

Window > Preferences でウィザードを開きます。Variant Management  >  pure::variants License を

選択し、Install License をクリックして現れるエクスプローラ画面で、上でコピーしたライセンス

ファイルを指定してください。次のように  License Data の情報が表示されます。 

 

◼ クライアントライセンスの更新 

pure::variants  クライアントがライセンスを要求しない場合にライセンスを更新するには、上記

と同様、メニューから  Window > Preferences でウィザードを開き、Variant Management  >  

pure::variants License を選択し、Install License をクリックしてください。 

◼ フローティングライセンス使用時の設定 

フローティングライセンスをご使用の場合、ライセンスサーバーの  URL  をクライアントライセ

ンスに設定してライセンスサーバーに接続できるようにします。 

クライアントライセンスファイル (xxx_client_license.lic) では、 

 <subtype>licence server</subtype> 

として URL を設定せずに送付されますので、下図のように subtype タグの url 属性を挿入して

クライアントライセンスファイルで URL を指定します 3。この URL  は、次章ライセンスサーバー

 
3  この操作を実施しない場合、Preferences  ウィザードから  Variant Management > pure::variants License > 

License Server で、ライセンスサーバーの  URL  を設定します。(Setup Guide  の  4.9.1. Setup License Server 

Location  を参照) 
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のインストールで設定する Address  と Port  からなるものです。 

 

 

サーバーのロケーションの設定について 

上記のようにしてサーバーの URL  を指定するかわりに、実行中の pure::variants  の中から以下

のようにして設定することもできます。 

メニューで  Window > Preferences とし、Preferences ウィザードで  Variant Management > 

pure::variants License > License Server を選択して、Floating License Server フィールドにサーバー

の  URL を入力します。この手順はワークスペースごとに行います。  

 

  

<?xml version="1.0" encoding="UTF-8"?> 
<licence version="1.1"> 
  <product> 
    <name>pure::variants</name> 
    <version>5</version> 
    <function>de</function> 
    <platform>win32</platform> 
  </product> 
  <creation>1-8-2021</creation> 
  <type>float</type> 
  <subtype url="http://pvlicense.example.com:80">licence server</subtype> 
  <registration> 
    <firma>ACME Inc.</firma> 
    <name>Jane Doe</name> 
    <email>jane.doe@acme.acme</email> 
    <number>1234567890ABCD</number> 
  </registration> 

<signature>12 … EF</signature></licence> 

ポート番号を含む完全ドメイン名で設定します。 

（デフォルトのポート番号：HTTP では 80、 

 HTTPS では 443、の場合は省略できます） 
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＊ライセンスの参照について補足と注意 

pure::variants  クライアントがライセンスを参照する際、Eclipse  のワークスペース、もし

くは Roaming  フォルダ4
 に作成されたライセンスのコピーが参照されます。 

3.4節「pure::variantsデスクトップクライアントライセンスのセットアップ」の手順で 

pure::variants  クライアントにライセンスをインストールすると、ワークスペースにライセ

ンスがコピーされて有効になります。 

また、Roaming  フォルダに de.license というファイルが作成されてライセンスがコピー

され、ワークスペースにライセンスがない場合に、このファイルが参照されます。 

ライセンスインストール時にライセンスファイルで  URL  が指定されなかった場合、URL  

指定を含まない  de.license がコピーとして参照されることになります。なお、この 

de.license ファイルは元のライセンスファイルを修正して  pure::variants  クライアントに

インストールした時点で上書きされます。 

上記でライセンスが見つからなかった場合、環境変数  PVLICENCE が示す場所からライセ

ンスを参照します。したがって、ライセンスは次の順で探索され、参照されることになりま

す。 

1. ワークスペース 

2. Roamingフォルダ以下 

3. PVLICENSE 環境変数で指定される場所 

 

サーバーの  URL  指定せずにライセンスをインストールし、それで  de.license が作成さ

れて残っている場合、クライアントにおいてライセンスファイル確認のウィザードが出るこ

とがあり、pure::variants  をバッチ実行するような場合に不都合になることがあります。 

そのような場合、URL  を設定したライセンスファイルを再度インストールすると、

de.license が上書きされて確認ウィザードは出なくなります。 

  

 
4 C:\ユーザー\<ユーザー名>\AppData\Roaming\<p::v バージョン> の名前のフォルダです。 
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4. pure::variants ライセンスサーバーのインストール 

4.1 Windows インストーラーによるインストール 

Windows  インストーラーは、 pure::variants  のサイト http://www.pure-systems.com/pvde-

update からダウンロードできます。このダウンロードページはパスワードで保護されており、メ

ールアドレスとライセンスファイルにある登録番号でログインする必要があります。 

ライセンスサーバーのインストーラー「Setup License Server X.Y.ZZ.exe」（X.Y.ZZはバージ

ョン番号）をダウンロードし、ダブルクリックしてインストールを開始します。インストールに

は管理者権限が必要です。 

 
 

 

ライセンスサーバーを  Windows  のサービスとして実行することをお勧めします。これにより

システム起動時にライセンスサーバーが自動的に起動されます。 

 

Next > をクリックします。 

ライセンスサーバーを Windows

のサービスとして実行するかどう

かを選択します。 Next > をクリッ

クします。 

http://www.pure-systems.com/pvde-update
http://www.pure-systems.com/pvde-update
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ライセンス契約を読んで同意し、

Next > をクリックします。 

ライセンスサーバーをインストー

ルするフォルダを選択し、Next > 

をクリックします。 

Windows のスタートメニュー項

目の名前を入力します  (作成を無

効にすることもできます)。Next > 

をクリックします。 
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次に、ネットワークオプションを構成します。  

 

* Addressフィールドを空白のままにすると、ライセンスサーバーは使用可能なすべてのネ

ットワークインターフェースで自動的に有効になります。HTTPSを使用したサーバー通信

の暗号化には、ライセンスサーバーに X.509 証明書が必要です。証明書のセットアップは

インストーラーの別のウィザードで行われます。通信用のポートには、デフォルト値 

(HTTPの場合は80、HTTPSの場合は443)が最適です5。 

このポートがファイアウォールでブロックされたり、他のサービスによって使用されたりし

ないようにしてください。 

また、Address に設定するライセンスサーバーのホスト名がネットワーク内で解決可能なも

のであることにもご注意ください。 

 

 

* 証明書の形式はPEMである必要があり、他の型はサポートされていません。 

 
5 ポート番号は 0 ～ 65535 で、80 が HTTP での標準、443 が HTTPS での標準です。標準のポートを使用するとファイ

アウォールの問題が起こりにくくなります。 

Address には、ライセンスサービス

を有効にするホスト名か IP アドレ

スを指定します。 

「Encrypt ～」をチェックして暗号

化のオプションを選択すると、

HTTP の代わりに HTTPS  を使用

してライセンスサーバーの通信を

暗号化できます。 

Port で通信用のポートを指定しま

す。 

Next > をクリックします。 

暗号化を有効にした場合、上部の

ファイルフィールドに  X.509  証

明書のパスを入力します。証明書

がパスワードで保護されている

場合、Password フィールドにそ

のパスワードを入力します。 

Next > をクリックします。 
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* サーバーライセンスファイルをこのフォルダに今すぐ配置することも、後でライセンスサ

ーバーのWebインターフェースを使用してライセンスをインストールすることもできます。 

 

ライセンスサーバーにはWebインターフェースがあり、Webインターフェースを使用してライ

センスの管理ができます。 

次のウィザードでWebインターフェースを有効/無効にできます。 

 

* パスワードで保護する場合、HTTPSも有効にしてください。暗号化しないとパスワード

盗難のリスクがあります。 

 

p.16 の手順で Windows サービスのオプションを選択している場合、インストールが正常に完了

した後にライセンスサーバーが自動的に起動します。そのため、インストール後にコマンドラインや

スタートメニューからライセンスサーバーを起動するとエラーを生じます。 

  

License Pool でライセンスファイ

ルを保存するフォルダを選択しま

す。 

Log File でサーバーログのファイ

ルを指定します。 

Next > をクリックします。 

Password  フィールドにパスワー

ドを設定してWeb インターフェー

スを保護してください。 

Install をクリックすると、インスト

ールプロセスが開始されます。 
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4.2 pure::variants ライセンスサーバーのアンインストール 

pure::variants  ライセンスサーバーのアンインストールには、Windows  のスタートメニューで 

アプリと機能  から対象のサーバー ( pure::variants License Server 5.0  など)  を選択し、「アンインストール」

でアンインストーラーを実行します。 

別に、pure::variants  ライセンスサーバーのインストールフォルダからアンインストーラー 

(uninstall.exe) をダブルクリックして実行する方法があります。 

 

アンインストールには管理者権限が必要です。 

 
 

 
 

Next > をクリックします。 

Uninstall をクリックしてアンイン

ストールを開始します。 
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4.3 アーカイブからのライセンスサーバーのインストール (Linux へのインストール 6) 

pure::variants  のサイトhttp://www.pure-systems.com/pvde-update からライセンスサーバーのア

ーカイブをダウンロードして展開し、作成したディレクトリ (次が推奨です) に置きます。 

 /opt/pure-variants 

ライセンスファイルのディレクトリ 

 /opt/pure-variants/licenses 

を作成し、送付されたサーバー用のライセンスファイルをそこに置きます。 

展開したライセンスサーバーの  server ディレクトリにある  start.sh スクリプトをテキスト

エディタで編集し、次を設定します。 

• HOSTNAME：ライセンスサーバーが動作するサーバーマシンのホスト名かIPアドレス 

• PORT：サーバーマシンで通信するTCPポート番号 

• LICENSEDIR：ライセンスファイルのディレクトリ 

クライアントはここで指定したサーバーマシンのポートに接続できることが必要ですので、こ

のポートがファイアウォールでブロックされたり他のサービスで使用されないようにしてくださ

い。ポート番号は 0 ～ 65535 で、80 がHTTPでの標準、443 がHTTPSでの標準です。標準のポー

トを使用するとファイアウォールの問題が起こりにくくなります。 

start.sh を実行してサーバーを開始します。このスクリプトをシステム起動時に自動実行する

には、ご利用システムのドキュメントを参照ください。 

Web  インターフェースを有効にするには、start.sh スクリプトの最後にあるサーバーのコマ

ンド行で次のオプションを指定します。 

--enableweb 

--webpwd <パスワード> 

 
6 Windows でもアーカイブからインストールできます。Setup Guide の 4.2.2. Install from Archive を参照くだ

さい。 

アンインストール完了後、Finish

で終了します。 

http://www.pure-systems.com/pvde-update


 

22 

サーバーの Web  インターフェースは常にパスワードで保護されますので、安全なパスワードを

使用してください。 

 

4.4 ライセンスサーバー Web インターフェース 

ライセンスサーバーには  Web インターフェースがあり、フローティングライセンスの追加やラ

イセンスの更新、状況やログの確認、日割り単位でのオフサイトライセンスの貸し出しなどを行う

ことができます。詳しくは、Setup Guide の  4.5. Basic Setup with the pure::variants License 

Server Web Interface  の各項目を参照ください。 

下図はライセンスの概要や使用の詳細を表示する例です。 
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5. モデルサーバーと Web コンポーネントや Web クライアントのインストール 

◼ モデルサーバーのインストール  

ライセンスサーバーのインストールと同様、Windows  インストーラーを使用する方法とアーカ

イブから展開する方法 (Linux向け) があります。 

Windows  インストーラー「 Setup Database Server X.Y.ZZ.exe」とアーカイブは、

pure::variants  のサイト http://www.pure-systems.com/pvde-update  にあり、次のステップで実施

します。 

• データベースと ODBC  データソースのセットアップ 

• モデルサーバーのインストール 

• モデルサーバーのセットアップ 

詳細は、Setup Guide  の 6.1. Install pure::variants Model Server  を参照ください。 

 

◼ Web コンポーネントや Web クライアントのインストール 

Apache Tomcat  もしくは WebSphere Liberty  上に Web  コンポーネントの  WAR  形式ファイル 

(com.ps.consul.server.oslc-x.x.x.war) をコピーします。このアーカイブは  pure::variants  の

サイトの pure::variants Windows Installer package  にあります。 

Java実行環境（Oracle Java SE  や OpenJDK）は pure::variants 5.0 では Java 8、pure::variants 

6.0 では Java 11  が推奨されています。 

なお、pure::variants 6.0 での  Webコンポーネントや  Webクライアントのインストールでは、

デプロイメントテンプレートを使用した Docker によるデプロイが強く推奨されています。ユース

ケースに応じて３つのテンプレートが用意されており、コンポーネントのインストールやメンテ

ナンスが容易になります。 

詳細は、Setup Guide  の 5. pure::variants Deployment Templates for Docker  を参照ください。 

また、Setup Guide  の 10.1.1. Install pure::variants Web Components  で、Apache Tomcat  と 

WebSphere Liberty  のインストール、構成設定について説明されています。 

 

  

http://www.pure-systems.com/pvde-update
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6. Eclipse 環境の日本語化 

ここでは、Babel Project  による方法を紹介します。pure::variants IDE (Eclipse) メニューのア

ップデートマネージャー ( Help > Install New Software...  ) からインストールできます。 

本例（インストールしたEclipseのバージョンが  4.10）の場合、Available Software の  Add 

Repository  ウィザードで以下の URL  を Update Site として Location欄に登録して接続し、日本語

化言語パックを選択してインストールしてください。 

https://archive.eclipse.org/technology/babel/update-site/R0.17.1/2018-12/ 

 

 

 

 

Name のリストを探して日本語 (Babel Language Packs in Japanese) にチェックを入れ、Next > 

します。 

 

https://archive.eclipse.org/technology/babel/update-site/R0.17.1/2018-12/
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* ここで、次図のように第2レベルのリストで、Babel Language Pack for rt.rap Japanese  のチ

ェックを外してください。 

 

これで日本語化に対応した必要なパッケージが選択されますので  Next >  で次に進みます。 

License Agreements  の画面では、同意して Finish  でインストールを開始します。 

Security Warning  の確認画面では、Install anyway  を選択して先に進みます。残りのパッケージ

がインストールされ再起動を促すダイアログが表示されます。 

 

Restart Nowで Eclipse  が再起動されて各種メニューが日本語化されます（いくつかのメニュー

は日本語化されません）。 
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7. クライアントの実行 

7.1 サンプルプロジェクト 

各種サンプルプロジェクトは、メニューの ファイル  から 新 規  > サンプル  で開くことができます。 

 

 

 

 

 

 

 

 

 

 

 

 

ヘルプファイルは、ヘルプ > ヘルプ目次 から開くことができます。 

また、以下のサイトに各種チュートリアルも置いていますので、ご参考いただけると幸いです。 

http://www.fuji-setsu.co.jp/products/purevariants/tutorials.html 

 

 

 

 

http://www.fuji-setsu.co.jp/products/purevariants/tutorials.html
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7.2 エラーログ 

実行時のエラーログは、Eclipse クライアントのワークスペース内の.metadataフォルダ

に.logとして格納されます。  

 

 

pure::variants の使用時に何らかのエラーが出る場合は、その状況に応じて以下のログ情報

を取得してください。  

• pure::variants  は起動しているが、プロジェクトのファイル（.xfmや.vdm）がエラーで開

くことができない場合：  

pure::variants  メニューの  ヘルプ から「Eclipse  プラットフォームについて」ウィザードを表示し、 

 

インストール詳細  のクリックで表示される下図「Eclipse  プラットフォームのインストール詳細」ウィザー

ドで、構成タブ の  エラー・ログの表示  をクリックして得られるログ  
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• 各種ツールのコネクタに関わるエラーの場合：  

それぞれのツール内で  pure::variants  メニューの  ウィンドウ  > 設定  で開く  Preferences  ウ

ィザード内のログ情報（このログファイルは、Roamingフォルダ- p.14脚注4参照- にもあ

ります）  
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Appendix ライセンスが起動しない場合 

 

ライセンスが起動しない場合、以下の部分に説明がある、ログ情報を参考ください。  

  

• クライアント側：p.27 の実行時のエラーログ  

• サーバー側：p.19 上側のダイアログで「Log File」に指定するファイル  

  

良くわからない場合は、これらをお送りいただけると、状況を考察することができるかと思い

ます。  

  

ちなみに、以下はありがちなケースです。  

  

• 既にサービスで起動しているのにコマンドから起動しようとしていた  

インストール時に「Windows サービス」と指定している場合、サーバーはインストール後に

すでに動作していますので、さらにコマンドラインからなどで起動しますと、指定のポート

（80 番）のバインディングエラーになりますのでご注意ください。(p.19 を参照ください) 

サービスとして起動しているかは、ブラウザーでサーバーのアドレスを入力するとウェブイ

ンターフェースが開くことでわかります。  

  

• 該当のポートをブロックしていた   

ポート番号 80 がファイアウォールで閉じられていたということが以前ありました。この場

合は、ファイアウォールで該当ポート番号の通信を許可するか、空きのポートに変更したと

ころ問題が解消しました。(p.18 を参照ください) 

 

 

 

 

 

 

 

 
富士設備工業株式会社 電子機器事業部 

Tel: 072-252-2128  www.fuji-setsu.co.jp 

http://www.fuji-setsu.co.jp/

